
Chapter 4
Basics
This chapter outlines the basic skills you'll need 
to construct drawings in Diagram! You will learn 
how to launch Diagram!, set up a document and 
work with modes and buttons. You'll also learn 
how to create and modify symbols and lines, and 
how to enter and edit text.
You should be able to work your way through this 
chapter in about forty-five minutes.

Launching Diagram!
First let's start Diagram! if it is not already running. Locate its icon in the Workspace and double-click
it.

 
 D!2Icon.tiff ¬
 

Your screen should now look like this:
 

 paste.tiff ¬



 

After you launch Diagram!, your screen should look like the picture above. In the upper left corner, you'll note Diagram!'s menu. 
Next to that, you'll find the Inspector panel and the palette window. The large white window is your document, and the place 
you'll create drawings.

Navigating In Diagram!
 

Now that you've launched Diagram!, let's define its basic components and tools:
 

Document window
The document window is the canvas on which you'll be drawing. As we'll see shortly, you can easily 
place shapes and text in the document window, and use a variety of guides and tools to assist you in
formatting them.

 

Button ribbon
Many of Diagram!'s drawing modes, features and tools are accessed by a button ribbon at the top of 
the document window. The five buttons at the very left of the ribbon provide access to Diagram!'s 
modes: Selection, Text, Line, Symbol and Zoom.

    
 ModeButtons.tiff ¬

Palette window
Diagram! palettes can be thought of as libraries where different symbols and lines are stored. In the 
upcoming chapters, you'll learn how to drag and drop these items from the palette into your 
document window.

 

Inspector panel
This panel provides four groups of controls for modifying Diagram! drawings.

 

Attributes inspector



Controls the shape of symbols and lines, how and where they display text, and whether or not a 
symbol has an image or an attachment.

 

Style inspector
Controls symbol and line color, shadow, stroke and fill.

 

Position inspector
Controls rotation of symbols, groups and labels. Also regulates the size and location of symbol and 
lines.

 

Sound inspector
Controls sound attachments to symbols.

Creating A New Document
 

In this lesson, you'll work your way through making this simple drawing:
InitialDoc.tiff ¬
 

If you would like to refer to this drawing on-screen or in printed form while you are working in the 
tutorial, open a copy of it from the Samples file located in the Info menu:

 

1. Choose the Samples command from the Info menu.
 

A standard Workspace file viewer appears. 
 

2. Select the "Basics.diagram2" file.
 

3. Choose the Open command from the Workspace File menu, or double-click the file.
 

Once the document is open, choose Print from Diagram!'s main menu to print a copy.



Checking The Preferences
 

To make sure your document is set up correctly for this tutorial, you'll need to take a quick detour.
Open Diagram!'s Preferences panel by choosing the Preferences command from the Info menu. 

 

When the Preferences panel appears on your screen, make sure that the Old Drawing Style 
preference is not selected. If it is, just click the check box to deselect it. The Preferences panel 
should appear as follows:
 
Preferences.tiff ¬ 

Document Layout
 

Before we proceed with creating a drawing, let's take a brief look at document layout. In the Page 
Layout panel, you can define a document's page orientation (portrait or landscape), margin settings,
number of pages and their position in relation to one another.
 

1. Choose the Page Layout command from the Format menu.
    
PageLayout.tiff ¬
 

When the Page Layout panel appears, make sure your document is set to Landscape (11" x 81/2" 
page orientation). 
 

2. Locate the Number of Pages section on the Page Layout panel. 
 

The collection of white and gray squares in this section is a miniature representation of your 
canvas. Each gray square represents a potential page that can be added to your document. The 
number of white squares indicates the number and layout of pages in a document.

 

For more information on the Page Layout panel, please refer to Chapter 26.
 



3. Click the OK button to apply the page settings and to exit the Page Layout panel.

Creating And Modifying Symbols
 

Let's begin by drawing some of the basic shapes we see in our sample document. There are a few 
ways to go about adding symbols to a drawing, but the two easiest are dragging and dropping from 
the palette and using the Symbol mode button. Let's start with the palette method:
 

1. Locate the parallelogram on the palette and position the cursor over it.
 
 PaletteDefault.tiff ¬
 

2. Click, and without releasing the mouse button, drag the cursor out of the palette 
window.
 
 PaletteDrag.tiff ¬
 

Notice that you have picked up a copy of the parallelogram by clicking and dragging.
 

3. Drag the copy of the parallelogram to the document window.
 
 PaletteDrop.tiff ¬
 

The cursor changes from an arrow to the copy cursor , indicating that dropping the symbol (by 
releasing the mouse button) will now place the symbol in the document.

 

4. Release the mouse button to "drop" the symbol.
 
 SelectedDiamond.tiff ¬
 

Eight resize knobs (small gray boxes) appear around the perimeter of the symbol. When the resize
knobs are visible, the symbol is selected. Clicking outside of the parallelogram in the document 
window causes the resize knobs to disappear, and deselects the parallelogram.

 

5. Drag and drop a circle from the palette into your document. Place it near the 



parallelogram.
 

6. Practice selecting and deselecting each of these symbols by clicking them.
 

Note that clicking one symbol automatically deselects the other. By holding down the Shift key 
when you click, however, you can select more than one item at a time. This is known as multiple 
selection.

 
 

Another way to select additional items (called "drag-selecting") involves clicking and dragging a 
region which intersects the desired objects.
 

1. Position the cursor on a blank portion of the canvas, press a mouse button and drag 
without releasing the mouse button.

 

Notice that a gray rectangle trails behind the cursor, and that any items that intersect this gray 
rectangle become selected.

 

2. Drag the cursor until the gray rectangle touches both the circle and the 
parallelogram, then release the mouse button.

 
 DragSelect.tiff ¬
 

Both symbols are now selected.
 

Moving and resizing symbols
 

To move a symbol, simply click inside its bounds and drag it towards the desired location. In effect, 
clicking "picks up" the symbol, and dragging "carries" it to its new location.
 

1. Position the cursor over the center of the parallelogram, then click and drag it to the
upper left hand portion of your document window.

 



You can drag symbols and other items whether they are selected or deselected. However, upon 
releasing the mouse button after repositioning a symbol, the symbol is selected.

 

2. Now that the parallelogram is selected, click and drag the resize knob in the lower 
right corner of the symbol to resize it:

 
 ResizingDiamond.tiff ¬
 

When you drag the resize knobs on the corners of a symbol, you can resize in any direction that 
you choose. But when you drag the middle resize knobs, you can resize in only one direction.

 

Copying and pasting
 

1. With the parallelogram selected, choose the Copy command from the Edit menu, 
then choose the Paste command.

 
 CopyPastedDiamond.tiff ¬
 

This sequence of commands creates an identical copy of the originally selected parallelogram. The
Copy/Paste commands provide a convenient way of creating duplicate copies of selected symbols.

 

Deleting
 

1. Reposition the newly-added parallelogram to the middle of the document.
 

2. With the parallelogram selected, press the Delete key to remove it from your 
drawing.

 

Pressing the Delete key, or selecting Delete from the Edit menu, removes currently selected 
symbols from your drawing. 

 

You should now be familiar with dragging and dropping symbols from the palette, as well as 
repositioning, resizing, copying and pasting, and deleting symbols. 



Another Method Of Drawing: Symbol Mode
 

Let's look briefly at another way to add symbols to the drawingÐ Symbol mode. In Symbol mode, 
you'll use the cursor to draw directly on the canvas by clicking and dragging.
 

1. Click the Symbol mode button in the button ribbon at the top of your document 
window.

 
 652092_ModeButtons.tiff ¬
 

The cursor appears as a crosshair.
 

2. Position the cursor in a blank portion of your document, and click and drag to create
a rectangle. Release the mouse button to place the symbol.

 
 SymbolModeDrawing.tiff ¬
 

The symbol now appears in the document and is selected, just as if it were dragged and dropped in 
from a palette.
For now, this is just a quick introduction to an alternative means of adding symbols to your 
document. Some people prefer to use the palettes to drag and drop new symbols into their drawing, 
while others prefer the mode button method. Whichever you choose, the end results are identical.
 

As a side note, the Symbol mode doesn't always produce rectangles: if you're interested, refer to 
Chapter 8 of this manual's Concepts section to learn more about how to set this type of behavior. 
We'll learn more about some of the other modes later on.
 

Before we continue, you should create the rest of the symbols that you need for this drawing, as 
pictured below.
 

1. Add three circles, two diamonds, three more rectangles and a horizontal arrow.
 

If you encounter any problems, just repeat the steps described in the previous few pages.
 



2. Position them as pictured below:
 

 InitialDocInProgress.tiff ¬

Adding Text
 

Presuming you've placed all the necessary symbols in your drawing, let's begin adding text. 
Diagram! adheres to the NeXTSTEP conventions for text entry and modification. Accordingly, you 
can apply all the same formatting, editing and spell checking functionality that's available in 
standard applications such as Mail and Edit.
 

Free-standing text
 

We'll start by adding the title at the top of the drawing. To place text in free space like the "Getting 
Your Driver's License" title, first switch to Text mode.
 

1. Click the Text mode button on the button ribbon to enter Text mode.
 

2. Position the cursor, which appears as an I-beam, in the upper left corner of the 
document and click once.

 
 EmptyTextBlock.tiff ¬
 

A gray box appears with a blinking insertion point.
 

3. Type the words "Getting Your Driver's License" and press the Enter key to exit Text 
mode.

 
 GettingDriverTitle.tiff ¬
 

Notice that the text has extended beyond the boundaries of its resize knobs.
 

4. With the text selected, grab one of its resize knobs and make it larger.
 
    GettingDriverTitle2.tiff ¬
 



All of the text you entered is now visible. Now let's change the title's point size and font:
 

1. With the text selected, raise the Font panel by choosing the Font Panel command 
from the Font submenu of the Format menu.

 

2. Select Helvetica Medium, point size 18. Click the Set button.
 
 FontPanel.tiff ¬
 

The title should now look like this:
 
 FinalTitleText.tiff ¬
 

These are the basic steps that you should follow to add free-standing text to a drawing, and to 
modify the point size and font of a selection of text. With regards to selecting and resizing, free-
standing text behaves exactly like a symbol. In fact, in later chapters, you'll learn that free-standing 
text is really text contained in an "invisible" symbol (one that has its fill, shadow and stroke turned 
off).
 

Adding text to symbols
 

Let's look how to add text to an existing symbol:
 

1. Double-click the rectangle in the upper left portion of your document.
 

Double-clicking a symbol or line automatically enters Text mode, indicated by a blinking insertion 
cursor.

 

2. Type the words "Enter the Department of Motor Vehicles building" and press the 
Enter key. Resize the symbol so that all of the text is showing.

 

Your symbol should look as follows:
    EnterDMV.tiff ¬

3. With your symbol selected, raise the Font panel.



 

4. Select 10 point Helvetica Medium, and click the Set button. Reduce the size of the 
symbol so that the 
text fits well.

 

Your symbol should now look like this:
 
 EnterDMV10pt.tiff ¬
 

Now let's work on placing text in the remaining symbols, as pictured in the sample drawing.
 

1. Double-click the second rectangle and type "Stand In Line."
 

2. Press the Tab key.
 

Notice that the cursor jumps between symbols and automatically enters them into Text mode. 
Hitting Shift-Tab will take you back a symbol. Diagram! cycles through the symbols according to 
their placement, ordered top-left to bottom-right. 

 

To enter a Tab character in text, type Alternate-Tab.
 

3. Repeat this process (enter a symbol's text from the sample drawing, then Tab to the 
next symbol) until all of the text in the drawing is entered.

 

Note that text in a symbol automatically wraps to fill the symbol when it's resized.

Drawing And Modifying Lines
 

Almost any kind of line can appear in a Diagram! drawing. They can join two symbols, appear in free 
space on the page, or connect two points on different lines.
 



Free-standing lines
 

First, let's draw a free-standing line.
 

1. Click the Line mode button on the button ribbon.
 

The mouse cursor changes to a crosshair.
 

2. Click in the white space above the title of the document, and drag to the right. 
 

Clicking drops the beginning of a line, and the line is drawn to the cursor's current position, as 
pictured:

 
 TitleLine.tiff ¬

3. Drag over to the right of the document, as pictured in the sample, and double-click 
to end the line in free space.

 

Double-clicking ends line drawing and returns you to the Selection mode. Note also that the line 
you've just drawn is selectedÐits endpoints appear as hollow white dots. The technique for 
selecting and deselecting lines is identical to those used for symbols.

 

4. With the line selected, click the Style button on the Inspector panel. 
 

The following Inspector panel appears:
 
 StyleInspector.tiff ¬
 

5. Drag the Thickness slider to the left or right, making the line thinner and thicker as 
you go. Leave it slightly thicker (don't worry about the exact size).

 

Your line should now look like this:
 
 TitleThickerLine.tiff ¬
 

Moving lines
 



Just like symbols, lines are moved by clicking and dragging. Very thin lines are sometimes hard to 
hit, but keep tryingÐwith practice, it becomes much simpler.
 

1. Click and drag the line to reposition it beneath the title.
 

Be careful not to click and drag one of the line's endpoints. Doing so will just move the endpoint, 
and 
not the whole line.

 

Your title should now look like this:
 
 TitleThickLineAtBottom.tiff ¬

 

Lines between symbols
 

In the previous section, we learned how to draw free-standing lines in a document. One of 
Diagram!'s biggest advantages, however, lies in its handling of lines that connect symbols. In this 
section, we'll learn how to draw lines between symbols.
 

1. Again, click the Line mode button on the button ribbon.
 

2. Position the crosshair on top of the "Enter the Department of Motor Vehicles 
building" rectangle, then click and drag toward the "Pick up forms" circle, as pictured 
below.

 

A line appears from the rectangle and follows the cursor as you move the mouse:
 
 DragLine.tiff ¬
 

3. Click again over the circle.
 

A line now joins the two symbols and appears as follows:
 
 CompleteLine.tiff ¬
 
 



Now, let's add an arrowhead to the line. 
 

4. With the line selected, click the Attributes button on the Inspector panel.
 

The following Inspector panel appears:
 
 AttributesInspectorLines.tiff ¬
 

The two scrolling lists display the line markers available for the line's head and tail.
 

5. Click the single arrowhead in the Head scrolling list of line markers.
 

With the line deselected (just click on a blank portion of your document), your line should now look
as follows:

 
CompleteDeselectedLine.tiff ¬ 
 

6. Reposition either of the symbols to see how Diagram! automatically maintains line 
connections between symbols. 

 

This is one of the fundamental advantages of Diagram!: you can freely reposition symbols without 
worrying about maintaining lines or connections. 

 
 Rubberbanding.tiff ¬
 
 

Now let's work on drawing the remainder of our lines. Rather than continue to click the Line mode 
button, draw a line, then modify it, let's use a faster method. If you're going to draw a series of lines 
that are all the same style, it's faster to make Line mode "sticky," which prevents Diagram! from 
always toggling back to the Select mode after you've completed drawing a line.
 

1. Click the Line mode button twice to make it "stick."
 

The button ribbon now looks like this:
 
 LineModeSelected.tiff ¬
 

Clicking a mode button twice causes Diagram! to remain in that mode even after you've 



performed a task. 
 
 
 

In this particular circumstance, it would also be easier if the line tool drew all of the lines with 
arrowheads, rather than requiring the use of the inspector to individually add arrowheads.
 

1. With Diagram! in Line mode, click the single arrowhead in the Head scrolling list.
 

This sets the default of the line tool to draw lines with arrowheads.
 

2. Draw the remainder of single-segment, straight lines. Don't worry about the lines 
with corners just yet.

 

Notice that they all now have arrowheads.
 

Lines with bends
 

In the previous sections, we learned that dragging from one symbol to another created a straight 
line between two symbols.
 

To create a multi-segment line, or one with corners in it, click after you've begun drawing a line. This 
drops a "bend point," or adds a point to the line. You can now continuing drawing the line in any 
direction you choose, which means you've effectively created a corner in the line.
 

1. While in Line mode, click and drag from the "Fill out forms" parallelogram to begin 
drawing a line.

 

2. Once a line is trailing behind the cursor, click again.
    
 BendPoint.tiff ¬

Notice that the line now has two segments, one you can move and one you can't. By adding as 
many segments as you like, you can create a line with virtually any shape.



3. Finish drawing the line, as pictured below. Add another corner by clicking again over
free space, and end the line at the "Forms complete?" diamond by clicking a final time 
over that symbol.

MultipleSegmentLine.tiff ¬

As with any other line, multiple-segment lines rubberband to track the movement of the drawing 
objects they connect.

Modifying the shape of lines
To modify the shape of a line, all you need to do is reposition its bend points.
1. To move a point in a line, first select the line by clicking it. 

Note again that a selected line's bend points are visible.
SelectedLine.tiff ¬

2. Select the bend point closest to the parallelogram.
All of the other points in the line disappear, while the selected point changes from white to black.

MovingBendPoint.tiff ¬

3. Drag the point up and to the right.
As you drag, the line automatically reshapes to track your mouse.

SelectedPoint2.tiff ¬

So to reshape a line, all you need to do is move its bend points. You've now learned the basics of 
drawing 
and reshaping lines.
4. Add the remainder of the multi-segmented lines to your drawing.



Saving
Save your drawingÐyou'll need it for the next chapter of this tutorial, where you'll refine it.
1. Choose the Save command from the Document menu, which will raise the Save 

panel.
2. Give your document a name, specify where you want it to be saved, and click the OK 

button.

Conclusion
In this chapter of the tutorial, you've learned the basic skills necessary for creating, resizing, 
repositioning and placing text in symbols. You've also learned how to modify the font and format of 
text, as well as the basics of drawing, repositioning and modifying lines.
In the next chapter, you'll flesh out these skills as you work your way through more complex 
modifications of the drawing you've created.


